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SUMMARY: 25 
The protocol describes the method of loading a fluorescent calcium dye through the cut nerve 26 
into mouse motor nerve terminals. In addition, a unique method for recording fast calcium 27 
transients in the peripheral nerve endings using confocal microscopy is presented. 28 
 29 
ABSTRACT: 30 
Estimation of the presynaptic calcium level is a key task in studying synaptic transmission since 31 
calcium entry into the presynaptic cell triggers a cascade of events leading to neurotransmitter 32 
release. Moreover, changes in presynaptic calcium levels mediate the activity of many 33 
intracellular proteins and play an important role in synaptic plasticity. Studying calcium 34 
signaling is also important for finding ways to treat neurodegenerative diseases. The 35 
neuromuscular junction is a suitable model for studying synaptic plasticity, as it has only one 36 
type of neurotransmitter. This article describes the method for loading a calcium-sensitive dye 37 
through the cut nerve bundle into the mice's motor nerve endings. This method allows the 38 
estimation of all parameters related to intracellular calcium changes, such as basal calcium level 39 
and calcium transient. Since the influx of calcium from the cell exterior into the nerve terminals 40 
and its binding/unbinding to the calcium-sensitive dye occur within the range of a few 41 
milliseconds, a speedy imaging system is required to record these events. Indeed, high-speed 42 
cameras are commonly used for the registration of fast calcium changes, but they have low 43 
image resolution parameters. The protocol presented here for recording calcium transient 44 
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allows extremely good spatial-temporal resolution provided by confocal microscopy. 45 
 46 
INTRODUCTION: 47 
The problem of measuring fast calcium waves in excitable cells is one of the most important 48 
and challenging aspects of studying signal transmission in the central and peripheral nervous 49 
systems. Calcium ions play an important role in triggering neurotransmitter release, synaptic 50 
plasticity, and modulation of the activity of various intracellular proteins1–5. Studying calcium 51 
signaling is also important for finding ways to treat neurodegenerative diseases6. To measure 52 
changes in the calcium levels, fluorescent calcium-sensitive dyes are commonly used, and 53 
changes in their fluorescence level are analyzed7–9. 54 
 55 
Loading of calcium dyes into cells can be achieved in different ways. Predominantly, cell-56 
permeant dyes are used10,11. However, in such a case, it is not only difficult to control the 57 
concentration of a dye inside the cell, but it is also hard to select target cells for loading. This 58 
method is not applicable for studying peripheral nerve endings since the dye enters 59 
postsynaptic cells. Instead, cell impermeant dyes are more suitable for such preparations. In 60 
this case, the dyes are delivered to the cells by microinjection or through a patch pipette12–14. 61 
There is also a method of loading through a nerve stump. The latter method is most suitable for 62 
neuromuscular junction preparations15–20. It allows performing staining for only cells of interest. 63 
Although this method does not provide an accurate evaluation of the concentration of the dye 64 
in the target cell, the concentration can be estimated approximately by comparing the level of 65 
fluorescence of the cells at rest in solutions with a known concentration of calcium21. In this 66 
study, a modification of this method applied to synapses of mammals is presented. 67 
 68 
Calcium entry during the depolarizing phase of the action potential is a fast process, especially 69 
in the neuromuscular junction; therefore, for its registration, appropriate equipment is 70 
required1. A recent study using a voltage-sensitive fluorescent dye demonstrated that the 71 
duration of the action potential in the peripheral synapse of a mouse is approximately 300 μs22. 72 
Calcium transient, evaluated using calcium-sensitive dyes in the peripheral synapses of the frog, 73 
has a longer duration: the rise time is about 2–6 ms and the decay time is about 30–90 ms, 74 
depending on the calcium dye used23,24. To measure fast processes with the help of fluorescent 75 
dyes, CCD or CMOS cameras are generally used, with fast and sensitive CCD matrices. However, 76 
these cameras have the disadvantage of low resolution, limited by the size of the sensitive 77 
elements of the matrix25–28. The fastest cameras with sufficient sensitivity to record both action 78 
potentials and calcium transients in response to low frequency stimulation of cells have a 79 
scanning frequency of 2,000 Hz, and a matrix with a dimension of 80 x 8029. To obtain signals 80 
with a higher spatial resolution, confocal microscopy is used, especially if it is necessary to 81 
assess some volumetric changes in the signal30–32. But it should be kept in mind that confocal 82 
microscopy has a high scanning speed in line scan mode, but there are still significant 83 
limitations on the speed of recordings of fast processes when building a spatial image33. There 84 
are confocal microscopes based on rotating Nipkow disks (slit-scanning microscopy) and 85 
Multipoint-Array Scanners, which have a higher scanning speed. At the same time, they are 86 
inferior to the classical confocal microscopes in confocal image filtering (pinholes crosstalk for 87 
microscopes with a Nipkow disk)32,34,35. Confocal imaging with resonance scanning can also 88 



 

provide a high spatio-temporal resolution required for high temporal measurements36. 89 
However, take into account that the registration of weak fluorescent responses at a high 90 
scanning speed when using resonance scanners requires highly sensitive detectors such as 91 
hybrid detectors36. 92 
 93 
This article presents a method for increasing the temporal resolution of signals recorded with 94 
the Laser Scanning Confocal Microscopy (LSCM) while maintaining the spatial resolution37. The 95 
current method is a further development of the methods described earlier and transferred to 96 
the LSCM platform38–40. This approach does not require changes in the microscope hardware 97 
and is based on the application of an algorithm for recording periodically evoked fluorescent 98 
signals with a time shift relative to the moment of stimulation. 99 
 100 
PROTOCOL: 101 
Experiments were performed on isolated nerve-muscle preparations of levator auris longus (m. 102 
LAL) from the Mice BALB/C (20–23 g, 2–3 months old)41. The experimental procedures were 103 
performed in accordance with the guidelines for the use of laboratory animals of the Kazan 104 
Federal University and the Kazan Medical University, in compliance with the NIH Guide for the 105 
Care and Use of Laboratory Animals. The experimental protocol met the requirements of the 106 
European Communities Council Directive 86/609/EEC and was approved by the Ethical 107 
Committee of the Kazan Medical University. 108 
 109 
1. Preparation of the Ringer’s and Filing solutions 110 
 111 
1.1. Prepare the Ringer’s solution for mammalian muscle by mixing the following ingredients: 112 
NaCl (137 mM), KCl (5 mM), CaCl2 (2 mM), MgCl2 (1 mM), NaH2PO4 (1 mM), NaHCO3 (11.9 mM), 113 
and glucose (11 mM). Bubble through the solution with 95% O2 and 5% CO2 and adjust its pH to 114 
7.2–7.4 by adding HCl/NaOH if necessary. 115 
 116 
1.2. Prepare the dye loading solution. 117 
 118 
1.2.1. Prepare HEPES (10 mM) solution with pH in the 7.2–7.4 range. 500 µg of commercial dye 119 
comes in a 500 µL vial. Dissolve the dye in 14 µL of the HEPES solution to obtain a dye 120 
concentration of 30 mM. Shake well and centrifuge until totally dissolved. 121 
 122 
1.2.2. Dilute the solution of Ca2+ indicator with HEPES solution down to 1 mM concentration. 123 
Keep it in a freezer (-20 °C) and avoid exposure to light. 124 
 125 
2. Dye loading procedure 126 
 127 
NOTE: The dye loading procedure is performed according to the protocol for loading through 128 
the nerve stump, adapted from the protocols previously published19,42–46. 129 
 130 
2.1. Dissect LAL muscle according to the dissection procedure for this preparation as described 131 
in the previously published protocols47,48. 132 



 

 133 
2.1.1. Fix the tissue slightly stretched (no more than 30% from initial length) in the elastomer-134 
coated Petri dish with fine stainless-steel pins and add Ringer’s solution until the muscle is fully 135 
covered. 136 
 137 
NOTE: The Petri dish was pre-filled with elastomer according to the manufacturer's instructions 138 
(see Table of Materials). 139 
 140 
2.2. Prepare the Filling Pipette 141 
 142 
2.2.1. Using a micropipette puller (see Table of Materials), prepare a micropipette with a fine 143 
tip which is as sharp as possible for the intracellular recordings. Use capillaries without internal 144 
filaments (1.5 mm in outer diameter and 0.86 or 1.10 mm in inner diameter). 145 
 146 
2.2.2. Break off the micropipette tip after scoring the taper with an abrasive, leaving the tip 147 
open to about 100 µm in diameter. Fire-polish the tip down to limit when the internal diameter 148 
shrinks from >80 μm to 12–13 μm. Attach a silicone tube to one side of the Filling Pipette and a 149 
syringe (without a needle) to the the other side. 150 
 151 
2.3. Under a stereomicroscope, find the place where the nerve trunk turns into separate nerve 152 
branches. Place the Filling Pipette with the mounted tube and the syringe on the Petri dish 153 
using wax. Move the pipette tip until it stands above the nerve. 154 
 155 
2.4. With fine scissors, cut the nerve close to the muscle fiber, leaving a small piece of the nerve 156 
stump about 1 mm long. Gently aspirate the nerve stump together with some Ringer’s solution, 157 
without pinching it, into the tip of the Filling Pipette. Remove the silicone tube from the Filling 158 
Pipette. 159 
 160 
2.5. Draw some amount of the dye loading solution (~0.3 µL) using a syringe with a long 161 
filament. This volume corresponds to approximately 3 cm of the filament. 162 
 163 
NOTE: Initially, it is necessary to make a filament from a pipette tip with a volume of 10 µL by 164 
pulling on the fire using an alcohol lamp or a gas burner. 165 
 166 
2.6. Gently insert the filament tip with loading solution into the Filling Pipette. Release the 167 
mixture directly onto the nerve stump. Incubate the preparation at room temperature in dark 168 
for 30 min. 169 
 170 
2.7. After that, rinse the preparation with fresh Ringer’s solution and incubate at 25 °C for up to 171 
2 h in a glass beaker with 50 mL (or more) Ringer’s solution (preparation must be covered with 172 
the solution). During this time, the dye will reach the synapses. 173 
 174 
3. Video capture with confocal microscopy 175 

 176 



 

NOTE: Registration of calcium transients is performed with a laser scanning confocal 177 
microscope (LSCM) (see Table of Materials). To register fast calcium transients, an original 178 
protocol that permitted recordings of signals with a sufficient spatial and temporal resolution 179 
was used. The method has been described thoroughly in the publication by Arkhipov et al37. 180 
The microscope was equipped with a 20x water immersion objective (1.00 NA). The 488 nm 181 
laser line was attenuated to 10% intensity and emission fluorescence was collected from 503 to 182 
558 nm. 183 
 184 
3.1. Mount the preparation into the silicon elastomer-coated experimental chamber and fix it, 185 
slightly stretched, with a set of steel micro-needles. Rinse the preparation extensively with 186 
Ringer’s solution. 187 
 188 
NOTE: A simple custom-made perfusion experimental chamber made of organic glass with the 189 
bottom of the chamber covered with an elastomer (prepared in accordance with the 190 
manufacturer's instructions; see Table of Materials) was used. The chamber has a solution 191 
supply tube. The solution is pumped out via a syringe needle, mounted on a magnetic holder 192 
(see Table of Materials). As an experimental chamber, a Petri dish could be used (like the one 193 
used for incubation of the preparation) but with attached supply and suction tubes. 194 
 195 
3.2. Install suction electrode which will be used to stimulate the nerve. 196 
 197 
NOTE: Construction of the electrode is similar to what was published in the 2015 paper by 198 
Kazakov et al49. Place and fix the electrode by waxing beside the bath. Move the tip close to the 199 
nerve stump and aspirate it into the electrode. 200 
 201 
3.3. Mount the preparation chamber onto the microscope stage and place the inlet and outlet 202 
fittings into the chamber. 203 
 204 
3.4. To perfuse the preparation, use a simple gravity-flow-driven system. Turn on the perfusion 205 
suction pump to remove the excess solution. 206 
 207 
3.5. Plug the stimulating suction electrode into an electric stimulator and ensure that muscular 208 
contractions occur after stimuli. See section 3.9–3.12 for stimulation conditions and recording. 209 
 210 
3.6. Fill up the perfusion system with the Ringer’s solution with d-tubocurarine (10 µM). 211 
 212 
NOTE: This solution helps to prevent muscular contractions. D-tubocurarine or alpha-213 
bungarotoxin-specific blockers of nicotinic acetylcholine receptors on the postsynaptic 214 
membrane would completely or partially block muscle contractions50. Also, for preventing 215 
muscular contractions, specific blockers of postsynaptic sodium channels such as µ-conotoxin 216 
GIIIB could be used51. 217 
 218 
3.7. Switch on the perfusion suction pump and start perfusion of the preparation with the 219 
Ringer’s solution containing d-tubocurarine. 220 



 

 221 
3.8. Set imaging parameters in the LSCM software as follows. 222 
 223 
3.8.1. In the LSCM software (LAS AF; see Table of Materials), choose Electrophysiology. 224 
 225 
NOTE: In this mode, when an image is captured at the time point, a synchronizing pulse is sent 226 
to the stimulator with the help of the trigger box. This elicits action potential generation in the 227 
preparation (Figure 1; stimulator unit). 228 
 229 
3.8.2. Select Acquisition Mode. For triggering the stimulator using the microscope sync pulse, 230 
in the Job menu settings, select the Trigger settings. Set the Trigger Out On Frame field to the 231 
out1 channel. 232 
 233 
3.8.3. Use the following settings: Scanning Mode: XYT, Frequency of Scanning: 1400 Hz, Zoom 234 
Factor: 6.1, Pinhole: fully open. Ensure that sequential trans-passing Bidirectional X mode is on. 235 
 236 
3.8.4. Set minimum time to form a frame at 52 ms and frames to be collected in a raw video at 237 
20 frames. 238 
 239 
NOTE: These settings permit image capturing with a resolution of 128 x 128 pixels while taking 240 
a single frame every 52 ms. 241 
 242 
3.8.5. Set excitation wavelength of the argon laser at 488 nm with 8% of output power. 243 
 244 
[place Figure 1 here] 245 
 246 
3.8.6. Press the Live Mode button to switch to Live mode, which helps to get a preview of nerve 247 
terminals loaded with the dye. 248 
 249 
[place Figure 2 here] 250 
 251 
3.9. Stimulation unit 252 
 253 
NOTE: In this work, the stimulator described in the article by Land et al.52 was used. This device 254 
allows for setting temporal parameters of stimulation via the MatLab software. 255 
 256 
3.9.1. Create a new file, paste the code from the above-mentioned article to the MatLab code 257 
window, and save the file. Click on Run, so a window with stimulation parameters appears. Set 258 
the delay time and duration of the stimulus. 259 
 260 
NOTE: The delay determines the temporal resolution of the reconstituted fluorescent signal. 261 
The electric pulse of 0.2 ms duration is delayed, and then sent to the isolation unit. The latter 262 
forms the amplitude and polarity of the stimulating pulse and electrically isolates the biological 263 
object from the recording equipment. 264 



 

 265 
3.9.2. To stimulate the nerve, select supramaximal amplitude of the stimulating impulse (25%–266 
50% greater than the maximum stimulation intensity necessary to activate all the nerve fibers). 267 
 268 
NOTE: The presented method is based on a special algorithm for recordings of single fast 269 
fluorescent signals using LSCM with the minimized sweep. At each step of the developed 270 
algorithm, the recorded fluorescent signal is shifted from the previous one by a time interval 271 
that is shorter than the microscope sweep. The value of time shifts determines the temporal 272 
resolution of the required signal. The number of steps (shifts) in the algorithm depends on the 273 
required temporal resolution and original temporal resolution. With this method of 274 
registration, the stimulation of the preparation is carried out with a frequency of 0.25 Hz. 275 
 276 
3.10. In the Live mode, search for the ROI and obtain the best focus. Run the data acquisition 277 
software. 278 
 279 
3.11. Shift the delay on the stimulator by 2 ms less relative to the previous value and run the 280 
data acquisition software. 281 
 282 
3.12. Repeat step 3.11 26 times to acquire 26 sequences, with each sequence shifted by 2 ms 283 
from the previous one. 284 
 285 
4. Video processing 286 
 287 
NOTE: A series of video images acquired by the confocal microscope is exported in the TIFF 288 
format with the free software LAS X (see Table of Materials). This series was divided into 289 
frames and exported to a folder. For generating the image sequence with higher time 290 
resolution, the ImageJ software, which has an open initial code for the analysis and processing 291 
of the data, was used. The algorithm of signals processing is represented schematically in Figure 292 
3. 293 
 294 
[place Figure 3 here] 295 
 296 
4.1. Run LAS X software. Open the project which was created during performing experiment. 297 
Click on Export, and then on Save As to save frames in .tiff format in the destination folder. 298 
 299 
4.2. Run the ImageJ software. Click on File > Import > Image Sequence. 300 
 301 
4.3. In the Open Image Sequence window, choose the destination folder and open the first 302 
frame. 303 
 304 
4.4. In the Sequence Options window, in the Starting Image field, set the frame number to 1 305 
for the first frame. In the Increment field, set the value equal to the number of frames in the 306 
initial signal recording (20 for the present case) and click on OK. 307 
 308 



 

4.5. To save the generated file of stitched first frames in a separate folder, click on File > Save > 309 
Folder. 310 
 311 
4.6. Repeat steps 4.3–4.5 for the next 19 frames. In the Sequence Options window, set the 312 
corresponding frame number in the Starting Image field. 313 
 314 
4.7. To generate the full high-time-resolution video, stitch all the frames together. To do this, 315 
click on File > Import > Image Sequence and select 1 in the Starting Image and Increment 316 
fields. The result will be the final video with increased temporal resolution. Save the file in .tiff 317 
or any other suitable format. 318 
 319 
5. Video analysis 320 
 321 
NOTE: In ImageJ, select ROI and background. Subtract background from ROI. Data is 322 
represented as the ratio, (ΔF / F0 - 1) * 100%, where F0 is the intensity of fluorescence at rest 323 
and ΔF is the intensity of fluorescence during stimulation. 324 
 325 
5.1. Click on Image > Stacks > Tools > Stack Sorter. Then, click on Analysis > Tools > ROI 326 
Manager. 327 
 328 
5.2. Drag and drop the .tiff file saved in step 4.7 into the ImageJ window. Expand the image for 329 
a better view. To improve image visualization, click on Image > Adjust > Brightness/Contrast > 330 
Auto. This step will not affect the data. 331 
 332 
5.3. Set the background close to the nerve terminal by drawing ROI. Add it to the ROI manager. 333 
Calculate the background by clicking on More > Multi Measure. Copy mean values, paste to the 334 
Spreadsheet program, and calculate the average. 335 
 336 
5.4. Subtract the calculated average value from the stacks by clicking on Process > Main > 337 
Subtract. Enter the value. 338 
 339 
5.5. Draw ROI around a nerve terminal via a polygon line. Add it to the ROI manager. 340 
 341 
5.6. Measure the intensity of the nerve terminal: Click on More > Multi Measure. Copy mean 342 
values and paste them to the Spreadsheet program. 343 
 344 
5.7. Calculate the average offset of signals. 345 
 346 
NOTE: Use the corresponding points depending on the delay time before stimulation. This step 347 
establishes the F0 value that will be used in subsequent calculations. 348 
 349 
5.8. Divide the signal values by the average offset value. 350 
 351 
NOTE: After this step, the signal does not contain the contribution of the background and raw 352 



 

fluorescence to the amplitude values for the selected ROI. 353 
 354 
5.9. Subtract 1 from values obtained in step 5.8, and then multiply by 100%. 355 
 356 
5.10. Plot a graph of Ca2+- transient and calculate the amplitude. 357 
 358 
REPRESENTATIVE RESULTS: 359 
After loading the preparation with dye according to the presented technique, most of the 360 
synapses located close to the nerve stump had a sufficient level of fluorescence (see Figure 2). 361 
After loading preparation with the dye and applying the described method of registration and 362 
image processing, calcium transients with the desired spatial and temporal resolution were 363 
obtained (see Figure 4). The calcium transient has been recovered by the proposed method 364 
(see Figure 3). 365 
 366 
Amplitude and time parameters of the recovered signals were also analyzed. Average data are 367 
presented in Table 1. 368 
 369 
[place Figure 4 around here] 370 
 371 
[place Table 1 here] 372 
 373 
Calcium transient analysis makes it possible to assess the amplitude-dynamic characteristics of 374 
changes in the presynaptic calcium level in the nerve ending during the action potential11. The 375 
change in the amplitude of the calcium transient correlates well with the change in the quantal 376 
content53. Calcium transient amplitude analysis is commonly used to study the effect of 377 
physiologically active compounds associated with modulation of presynaptic calcium levels on 378 
synaptic transmission54,55. The time course of the calcium transient reflects the kinetics of 379 
calcium binding with the dye and its dissociation23,56. It is obvious when using dyes with 380 
different affinity for calcium23,56. Although the temporal parameters of the calcium transient 381 
reflect the kinetics of the calcium sensitive dye, and do not represent the kinetics of free 382 
calcium in the nerve terminal, mathematical modeling methods based on experimental data 383 
can restore the behavior of free calcium in the cell and calculate the concentration of calcium 384 
buffers23. 385 
 386 
FIGURE AND TABLE LEGENDS: 387 
Figure 1: The schematic of the experimental setup. 1. Laser Scanning Confocal Microscope 388 
(LSCM). 2. Synchronization module of LSCM (trigger box). 3. Stimulator. 4. Isolation unit. 5. The 389 
biological sample. 6. Suction electrode for electrical stimulation of nerve. 7. Perfusion systems 390 
(7a: perfusate reservoir, 7b: dropper, 7c: flow regulator, 7d: vacuum flask). Arrows point to the 391 
direction of propagation of synchronizing pulse. 392 
 393 
Figure 2: Mouse nerve and terminals loaded with the Ca2+ indicator. 394 
 395 
Figure 3: Scheme for compiling a high-resolution video file (2 ms on frame) from original 396 



 

video files with a low temporal resolution (52 ms on frame). The original video files and the 397 
corresponding signals are colored in black, magenta, and green. The compiled video file and the 398 
resulting signal are colored red. The scheme on the right, line by line, shows the video images 399 
obtained with a confocal microscope. On the left, the corresponding signals of fluorescence 400 
change from the selected ROI. The topmost line is formed frame by frame from the received 401 
frames according to the scheme. The result is a video image consisting of the entire array of 402 
frames so that there is a delay time of 2 ms between frames instead of 52 ms. Each line 403 
corresponds to an offset of the stimulation signal by (n - 1) * t, where t is time shift (2 ms), and 404 
n is the number of shift iterations. k denotes the number of frames in the original video files 405 
(lines 2–4) and depends on the duration of the recorded signal. In this case, to register a signal 406 
with a duration of 1 s, it is necessary to select k = 20 (52 ms * 20 = 1040 ms). t0 is the required 407 
delay before stimulation. To calculate the number of shift iterations n, the initial temporal 408 
resolution between frames (52 ms) must be divided by the required temporal resolution (2 ms). 409 
In this case, n = 26, which corresponds to 26 registered sweeps. As a result of the performed 410 
manipulations, a video image consisting of n * k = 520 frames is obtained. 411 
 412 
Figure 4: Representative trace of calcium signal from one experiment. Some important 413 
parameters of signal, such as mean amplitude (MA), rise time (RT), and decay time (DecT) and 414 
its projections on axes are indicated. MA is calculated by averaging points at the peak, colored 415 
in green. RT is the time taken for the amplitude to rise from 20% to 80%, which is calculated as 416 
the difference between projections on the x-axis colored in blue. DecT is the time over which 417 
the amplitude decreases by e times, which is calculated as the difference between projections 418 
on the x-axis colored in red. 419 
 420 
Table 1: The averaged parameters of the Ca2+ transient. Data are presented as mean ± s.e.m., 421 
and n is the number of measurements in the distinct nerve-muscle junctions. Peak ΔF/F is the 422 
mean amplitude of ΔF/F. 423 
 424 
DISCUSSION: 425 
The method for loading Ca2+-sensitive dye into mouse nerve endings through the nerve stump 426 
and for registering a fast calcium transient using a confocal microscope is presented in this 427 
article. As a result of the implementation of this loading method, most of the synapses located 428 
close to the nerve stump had a sufficient level of fluorescence to enable registration of the 429 
entry of calcium into the nerve endings in response to low-frequency stimulation of the motor 430 
nerve. 431 
 432 
Unlike the previously presented protocols for loading calcium dyes through the stump, this 433 
protocol is designed for use on mammalian synapses. Previous protocols used in cold-blooded 434 
animal preparations required an overnight incubation43. In this protocol, the required 435 
incubation with the drug is only 2 h. Depending on the length of the nerve segment that 436 
remained after the cutting, the speed of dye loading, and the number of loaded terminals may 437 
vary. It was possible to reduce the incubation time even further in dye solution for shorter 438 
nerve stumps. A similar method is described for the loading of fly synapses18,19. Also, the 439 
incubation of the muscle was carried out with a slight increase in temperature above the room 440 



 

temperature, which improves the diffusion of dye along the nerve. It thus helped to reduce the 441 
incubation time and, therefore, current dye loading method can be used for loading synapses of 442 
mammals that do not tolerate prolonged incubations. It is important to choose the appropriate 443 
preparations for the study. The LAL muscle is well suited for this method, as it is possible to cut 444 
a nerve stump close enough to the synaptic terminals. Other thin muscles can also be suitable 445 
for such application57. One of the most important steps in this protocol is that the nerve stump 446 
has to be placed into the dye-containing solution in the first few minutes after cutting the 447 
nerve. Since the length of the nerve is short, a specific design of the suction electrode must be 448 
used for stimulation. In this research, both glass and plastic electrodes were used, with the 449 
diameter comparable with that of the nerve segment. 450 
 451 
Acquiring calcium transients should be carried out using special equipment. Recordings of long-452 
lasting changes in calcium level in response to frequency stimulation of the motor nerve require 453 
regular cameras or a confocal microscope. While registration of calcium transients is in 454 
response to rare stimulation of the nerve, sensitive cameras are needed when the signal from 455 
the dye has low intensity and high speed11. Highly sensitive CCD cameras or matrices consisting 456 
of photodiodes are mainly used to register these fast processes. However, cameras with high 457 
sensitivity and speed tend to have low resolution. If high-resolution registration is required, 458 
confocal microscopy methods are more suitable. In confocal microscopes, photomultipliers are 459 
used to register fluorescence, and more recently, hybrid detectors came to use. They have a 460 
very high sensitivity compared to CCD cameras and are well suited for detecting weak 461 
fluorescence. But the main disadvantage of LSCM is low scanning speed when building a spatial 462 
image. In this study, to record the calcium transient, the original registration method was used 463 
via LSCM, which is described thoroughly in the article by Arkhipov et al. related to the synapses 464 
of the frog37. Using this method, it was possible to estimate the proximal-distal gradient of 465 
calcium transient in the elongated frog synapses37. This method of registration can be useful for 466 
assessing subcellular calcium dynamics in excitable cells, for example, in dendrites and spines in 467 
brain slice preparations. In the present study, it was applied to mammalian synapses. It allowed 468 
obtaining confocal video images with 2 ms sampling of signals to analyze the parameters of the 469 
calcium transient. 470 
 471 
The described method deals with fluorescent signals, triggered by an external stimulus and has 472 
a fixed delay before the stimulus has come. Varying the delay on the stimulator makes it 473 
possible to change the point of signal start and register the shifted signal by LSCM. Then, the 474 
original signal with a high temporal resolution is restored, using inverse convolution according 475 
to the algorithm described previously. One of the limitations of the current method is that the 476 
original signals must have little variability in parameters and have good reproducibility. For 477 
applying the method, one needs to perform several scans to get enough data for convolution. 478 
In the considered case, 26 trials with 20 frames each, i.e., 520 frames in total were recorded. 479 
The duration of imaging and the number of trials depends on the required time resolution and 480 
signal duration. So, focus position stability of the preparation during imaging is required. The 481 
accuracy of the signal recovery by the proposed method is mostly determined by the size of the 482 
ROI. The smaller the ROI size, the less time it takes to scan and the fewer errors occur during 483 
signal recovery with the required temporal resolution37. 484 



 

 485 
This study presented a method for loading fluorescent dyes into peripheral synapses of 486 
mammals and a method for recording fast fluorescent calcium signals via a confocal 487 
fluorescence microscope. Using the described method, it was possible to register a signal with 488 
good spatial and temporal resolution. Registration of calcium transients is a powerful tool in 489 
studying cellular processes, such as regulation of neurotransmitter release and synaptic 490 
plasticity54,55. 491 
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Peak ΔF/F (%) Rise time 20%-80% 

(ms)

τ (ms)
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Step 1.2.4: What was the initial concentration of the dye? What solution was used for 

diluting the dye? 

Answer 
We have changed the text according to your recommendations: 
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We have changed the text according to your recommendations: 
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Note: The petri dish was pre-filled with elastomer according to the manufacturer's instructions supplied. 

(see the Table of Materials). 

 

Step 2.12.: Volume of dye loading solution used. What does 3 cm indicate? 
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We have changed the text according to your recommendations: 
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Note: Initially it is necessary to make a filament from a pipette tip with a volume of 10 µl by pulling on 

the fire using an alcohol lamp or a gas burner. 

 

Step 3.1: Was a special experimental chamber used? If yes, please describe the chamber 

setup briefly here? How was the sample fixed? Please describe. 

Answer 
We have changed the text according to your recommendations: 

3.1. Mount the preparation into the silicon elastomer-coated experimental chamber and fix it, slightly 

stretched, with a set of steel micro-needles.  

Note: A simple self-made perfusion experimental chamber made of organic glass, the bottom of the 

chamber is covered with an elastomer (prepared in accordance to the manufacturer's instructions 



supplied; see Table of Materials) was used. The chamber has a solution supply tube. The solution is 

pumped out via a syringe needle, mounted on a magnetic holder (see Table of Materials). As an 

experimental chamber, a Petri dish could be used, the same as for incubation of the preparation, but 

with attached the supply and suction tubes. 

 

 

 

Step 3.4-3.5: How was the chamber setup? How was the sample placed along with the 

electrode? Please describe in brief. 

Answer 
We have changed the text according to your recommendations see previous Answer. 

How exactly the sample will be located in the camera and the electrode will be installed will 

be presented in detail in the video.  

 

Step 3.6.: what was the strength of the electrical stimulation given to observe contractions? 

How was this determined? 

Answer 
We have changed the text according to your recommendations and add information in 

section Stimulation unit : 

3.6. Plug in stimulating electrode to an electric stimulator and make sure occurring muscular 

contractions after stimuli. See section 3.10-3.15 for stimulation conditions and recording. 

See lines 264-266  

To stimulate the nerve, the supramaximal amplitude of the stimulating impulse is selected (25% –50% 

greater than the maximum stimulation intensity necessary to activate all the nerve fibers).  

. 

 

Step 3.11: How was the stimulation software setup? Please describe in brief. 

Answer 
We have changed the text according to your recommendations: 

3.10 Stimulation unit  

In this work the stimulator described in the article by Land et al. 51 was used. This device allows set 

temporal parameters of stimulation via the MatLab software. Create file, copy and paste the code from 

mentioned article to MatLab code window, then save. Click Run, a window with stimulation parameters 

will appear. Set delay time and duration of the stimulus. The delay determines temporal resolution of 

the reconstituted fluorescent signal. Electric pulse of 0.2 ms duration is delayed, then sent to the 

isolation unit. The latter forms the amplitude and polarity of the stimulating pulse and electrically 

isolates the biological object from the recording equipment. To stimulate the nerve, the supramaximal 



amplitude of the stimulating impulse is selected (25% –50% greater than the maximum stimulation 

intensity necessary to activate all the nerve fibers).  

Presented method based on special algorithm for recordings of single fast fluorescent signals using 

LSCM with the minimized sweep. At each step of developed algorithm, recorded fluorescent signal is 

shifted from the previous one by time interval which is shorter than the microscope sweep. The value of 

time shifts determines temporal resolution of required signal. Number of steps (shifts) in algorithm is 

depends on required temporal resolution and origin one. With this method of registration, the 

stimulation of the preparation is carried out with a frequency of 0.25 Hz. 
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of the Protocol (including headings and spacing) that identifies the essential steps of the 

protocol for the video, i.e., the steps that should be visualized to tell the most cohesive story 

of the Protocol. Remember that non-highlighted Protocol steps will remain in the 

manuscript, and therefore will still be available to the reader. 

Answer 
 
We have changed the text according to your recommendations 

 

 

10. Please include at least one paragraph of text to explain the Representative Results in 

the context of the technique you have described, e.g., how do these results show the 

technique, suggestions about how to analyze the outcome, etc. The paragraph text should 

refer to all of the figures, except for figures showing the experimental set-up. Data from both 

successful and sub-optimal experiments can be included. 

Answer 
 
We have changed the text according to your recommendations: 

See line 360-384 

REPRESENTATIVE RESULTS 

After loading the preparation with dye according to the presented technique, most of the synapses 

located close to the nerve stump had a sufficient level of fluorescence (see Figure 2). 

After loading preparation with the dye and applying the described method of registration and image 

processing, calcium transients with the desired spatial and temporal resolution were obtained (see 

Figure 4). The calcium transient has been recovered by the proposed method (see Figure 3). 

Amplitude and time parameters of the recovered signals were also analyzed. Average data presented on 

table 1. 

 [place figure 4 around here] 



 [place Table 1 here] 
 

Calcium transient analysis makes it possible to assess the amplitude-dynamic characteristics of changes 

in the presynaptic calcium level in the nerve ending during the action potential.11. The change in the 

amplitude of the calcium transient correlates well with the change in the quantal content52. Calcium 

transient amplitude analysis is commonly used to study the effect of physiologically active compounds 

associated with modulation of presynaptic calcium levels on synaptic transmission53, 54. The time course 

of the calcium transient reflects the kinetics of calcium binding with the dye and its dissociation23, 55. It is 

obvious when using dyes with different affinity for calcium23, 55. Although the temporal parameters of 

the calcium transient reflect the kinetics of the calcium sensitive dye, and do not represent the kinetics 

of free calcium in the nerve terminal, it could be suggested and the concentration of calcium buffers 

calculated via mathematical modeling based on experimental data23. 

 
11. Please include a short description of the data presented in the Figure and relevant 
symbols of each figure and/or table. Please include what the x-axis and y-axis represent.  
 

Answer 
 
We have add information in description figure legend: 

See line 386-418: 

FIGURE AND TABLE LEGENDS:  

Figure 1: The schematic of the experimental setup. 1: Laser Scanning Confocal Microscope (LSCM). 2: 

Synchronization module of LSCM (trigger box). 3: Stimulator. 4: Isolation unit. 5: The biological sample. 

6: Suction electrode for electrical stimulation of nerve. 7: Perfusion systems a-perfusate reservoir, b-

dropper, c-flow regulator, d-vacuum flask. Arrows point to the direction of propagation of synchronizing 

pulse. 

Figure 2: Mouse nerve and terminals loaded with the Ca2+ indicator. 

Figure 3: Scheme for compiling a high resolution video file (2 ms on frame) from original video files with 

a low temporal resolution (52 ms on frame). The original video files and the corresponding signals are 

colored in black, magenta and green. The compiled video file and the resulting signal are colored red. 

The scheme on the right, line by line, shows the video images obtained with a confocal microscope. On 

the left, the corresponding signals of fluorescence change from the selected ROI. The topmost line is 

formed frame by frame from the received frames according to the scheme. The result is a video image 

consisting of the entire array of frames so that there is a delay time is 2 ms between frames instead of 

52 ms. Each line corresponds to an offset of the stimulation signal by (n-1)*t, where t - time shift (2 ms), 

n - number of shift iterations. k- the number of frames in the original video files (2nd-4th lines) depends 

on the duration of the recorded signal. In this case, in order to register a signal with a duration of 1 

second, it is necessary to select k = 20 (52 ms * 20 = 1040 ms), t0 is the required delay before 

stimulation. To calculate the number of shift iterations n, the initial temporal resolution between frames 

(52ms) must be divided by the required one (2ms). In this case, n = 26, which corresponds to 26 

registered sweeps. As a result of the performed manipulations, a video image consisting of n * k = 520 

frames is obtained. 



Figure 4: Representative trace of calcium signal from one experiment. Some important parameters of 

signal, such as mean amplitude (MA), rise time (RT) and decay time (DecT), and its projections on axes 

are indicated. MA – calculated by averaging points at peak, colored in green. RT – the time while 

amplitude rise up from 20 to 80% and calculated as difference between projections on x axis, colored in 

blue. DecT– the time when amplitude decrease at e times and calculated as difference between 

projections on x axis colored in red 

 

 ____________________________________ 

Reviewers' comments: 

Reviewer #1: 

Manuscript Summary: 

The manuscript by Zhilyakov et al. describes a method for imaging fast calcium transients in 

the presynaptic nerve terminal of the mouse neuromuscular junction. While similar 

approaches have been used by some in other preparations, and calcium imaging has been 

performed previously at the mouse neuromuscular junction, this report is still valuable as it 

will provide a detailed procedure and video to aid investigators who are interested in using 

this approach at motor nerve terminals. There are a few issues that the authors should 

address. 

 

Major Concerns: 

None 

 

Minor Concerns: 

1. On line 48-49 when the authors are comparing cell permeant dyes with cell impermeant 

dyes, they state that when using cell permeant dyes it is difficult to control the concentration 

of the dye inside the cell. In fact, this is also an issue when using cell impermeant dyes in 

the manner described in this manuscript. Loading dyes through the cut end of the nerve 

does not allow the experimenter to know the concentration of dye within the nerve terminal. 

This should be made clear. 

Answer 

Thank you for suggestion, you're right. We discussed this in the introduction. 
. 

See line 63 -68:  

“There is also a method of loading through a nerve stump. The latter method is most suitable 

for neuromuscular junction preparations15–20. It allows performing staining only cells of interest. 

Although this method does not provide an accurate evaluation of the concentration of the dye in the 

target cell, it can be estimated approximately by comparing the level of fluorescence of the cells at rest 

in solutions with a known concentration of calcium21. In this study, we present a modification of this 

method applied to synapses of mammals.” 

 

2. On line 57, the authors comment that calcium entry during action potentials in the 

mammalian neuromuscular junction is a very fast process. The authors could cite a recent 

report that demonstrates that presynaptic action potentials have an exceptionally fast time 



course at the mammalian neuromuscular junction (Ojala et al., J Biol Chem. 2021 Jan-Jun; 

296: 100302). 

Answer 
 
Thank you very much for the information, we have added this to the text and a cite this 

work. 

See line 69-75 

“Calcium entry during the depolarizing phase of the action potential is a fast process, especially in the 

neuromuscular junction; therefore, for its registration, appropriate equipment is required1. Recent study 

using a voltage-sensitive fluorescent dye, demonstrated that the duration of the action potential in the 

peripheral synapse of a mouse is 300 μs approximately22. Calcium transient, evaluated using calcium-

sensitive dyes in the peripheral synapses of the frog, has a longer duration: the rise time is about 2-6 ms 

and the decay time is about 30-90 ms, depending on the calcium dye used23, 24” 

 

3. On line 104-105 and 333, the authors cite prior publications that employ calcium dye 

loading through the cut end of the nerve. They should consider adding two others: Luo et 

al., J Neurosci. 31:11268-81; Luo et al., J Neurophysiol. 2015 113:2480-9. 

Answer 
 
Thank you very much for the information, we have added cites in text: 

See line 130-131 

The dye loading procedure is performed according to the loading protocol through the nerve stump, 

adapted from the protocols previously published19, 42–46. 

 

 

4. Figure 3 is not described completely enough in the figure legend to easily understand the 

figure. A more detailed legend should be written.С 

Answer 
 
Thanks for the suggestion, we have added details to the description of the figure. 

See line 396-411: 

“Figure 3: Scheme for compiling a high resolution video file (2 ms on frame) from original video files with 

a low temporal resolution (52 ms on frame). The original video files and the corresponding signals are 

colored in black, magenta and green. The compiled video file and the resulting signal are colored red. 

The scheme on the right, line by line, shows the video images obtained with a confocal microscope. On 

the left, the corresponding signals of fluorescence change from the selected ROI. The topmost line is 

formed frame by frame from the received frames according to the scheme. The result is a video image 

consisting of the entire array of frames so that there is a delay time is 2 ms between frames instead of 

52 ms. Each line corresponds to an offset of the stimulation signal by (n-1)*t, where t - time shift (2 ms), 

n - number of shift iterations. k- the number of frames in the original video files (2nd-4th lines) depends 



on the duration of the recorded signal. In this case, in order to register a signal with a duration of 1 

second, it is necessary to select k = 20 (52 ms * 20 = 1040 ms), t0 is the required delay before 

stimulation. To calculate the number of shift iterations n, the initial temporal resolution between frames 

(52ms) must be divided by the required one (2ms). In this case, n = 26, which corresponds to 26 

registered sweeps. As a result of the performed manipulations, a video image consisting of n * k = 520 

frames is obtained.” 

 

 

5. The manuscript implies that the described method will allow the investigator to accurately 

measure the fast time course of the presynaptic calcium transient. However, the data 

shown in Figure 4 and the measured parameters of that signal in Table 1 reflect the kinetics 

of the calcium sensitive dye, and do not represent the kinetics of free calcium in the nerve 

terminal. The choice of dye is critical here and the authors should acknowledge this fact. 

This is nicely demonstrated by Sabatini and Regehr, Biophys J. 1998, 74:1549-63. 

 

Answer 
 
Thanks for the comment; we added a discussion of this to the results. 

See line 374-384: 

“Calcium transient analysis makes it possible to assess the amplitude-dynamic characteristics of changes 

in the presynaptic calcium level in the nerve ending during the action potential.11. The change in the 

amplitude of the calcium transient correlates well with the change in the quantal content52. Calcium 

transient amplitude analysis is commonly used to study the effect of physiologically active compounds 

associated with modulation of presynaptic calcium levels on synaptic transmission53, 54. The time course 

of the calcium transient reflects the kinetics of calcium binding with the dye and its dissociation23, 55. It is 

obvious when using dyes with different affinity for calcium23, 55. Although the temporal parameters of 

the calcium transient reflect the kinetics of the calcium sensitive dye, and do not represent the kinetics 

of free calcium in the nerve terminal, it could be suggested and the concentration of calcium buffers 

calculated via mathematical modeling based on experimental data23.” 

” 

 

Reviewer #2: 

Manuscript Summary: 

In this manuscript, the authors describe a protocol for live-imaging of synaptic calcium 

transients at the neuromuscular junction using the levator auris longus muscle from BALB/C 

mice. This method and approach will be valuable in the field for enabling real-time capture 

of these calcium transients involved in neuronal signaling events, in the mammalian setting. 

 

Overall the protocol seems to be straightforward, however more detail is needed in several 

places for execution using solely this article. Other previously published works are 

referenced, but the manipulations included from those papers are not described at all here, 

and the authors move forward onto later steps that would be problematic for a naïve user. 

As an individual familiar with similar protocols and usage of the software programs included 



herein, it also seems that several steps should be grouped together as step/sub-step 

processes rather than individual new steps, as indicated in the comments section. 

 

It is the impression of this reviewer therefore, that with sufficient editing and attention to fine 

detail, that this manuscript will be suitable for publication with revision and will provide a 

novel and extremely useful tool for other scientists looking to perform similar studies. 

 

Thank you for evaluating our work 

 

Major Concerns: 

Suggest a proofreading by a native English speaker. There are frequent inaccuracies in 

word agreements, usage of articles, and general phrasing. 

 

Answer 
 
We have edited the manuscript by a native English speaker. 

 

The authors do not present evidence of efficacy of their stimulation and recording, or a 

troubleshooting section. The sole figure which speaks to a positive response (Figure 4) is 

from a single synaptic region, and does not show the value of total magnitude of signal, or 

the length of the full time period that is represented. The authors fail to mention what a 

reasonable deltaF/F value is for a successful stimulation. Importantly, they also do not 

discuss the sensitivity of the assay- can this differentiate synapses that are less effective at 

firing, or is it an all-or-nothing response? They also do not discuss how technical and 

biological replicates can and should be combined, and therefore it is unclear how larger 

studies exploring synaptic maturation, degeneration, or therapeutic intervention could be 

designed or interpreted. 

 

Answer 
Thanks for the comment 

The main purpose of this article is to provide a protocol for loading a calcium dye and 

registering a calcium transient using a confocal microscope. Figure 2 shows the result of 

loading peripheral terminals using this technique. Usually all loaded terminals respond in 

response to stimulation with a calcium transient. This can be assessed with the eyes when 

previewing the specimen through the eyepieces. Figure 3 shows the result of registration 

and restoration of a calcium transient from one synaptic terminal. Table 1 provides statistics 

for several experiments. We have added material to the results section, which will expand 

the understanding of how to interpret the results obtained and further use the presented 

methodology. The average amplitude of the registered signals is 26 + _ (table), which 

makes it possible to evaluate the main characteristics of the transient. 

See line 360-384: 

“After loading the preparation with dye according to the presented technique, most of the synapses 

located close to the nerve stump had a sufficient level of fluorescence (see Figure 2). 



After loading preparation with the dye and applying the described method of registration and image 

processing, calcium transients with the desired spatial and temporal resolution were obtained (see 

Figure 4). The calcium transient has been recovered by the proposed method (see Figure 3). 

Amplitude and time parameters of the recovered signals were also analyzed. Average data presented on 

table 1. 

 [place figure 4 around here] 

 [place Table 1 here] 
Calcium transient analysis makes it possible to assess the amplitude-dynamic characteristics of changes 

in the presynaptic calcium level in the nerve ending during the action potential.11. The change in the 

amplitude of the calcium transient correlates well with the change in the quantal content52. Calcium 

transient amplitude analysis is commonly used to study the effect of physiologically active compounds 

associated with modulation of presynaptic calcium levels on synaptic transmission53, 54. The time course 

of the calcium transient reflects the kinetics of calcium binding with the dye and its dissociation23, 55. It is 

obvious when using dyes with different affinity for calcium23, 55. Although the temporal parameters of 

the calcium transient reflect the kinetics of the calcium sensitive dye, and do not represent the kinetics 

of free calcium in the nerve terminal, it could be suggested and the concentration of calcium buffers 

calculated via mathematical modeling based on experimental data23.” 

 

 

The authors state in their discussion (line 327-329) "most of the synapses located close to 

the nerve stump had a sufficient level of fluorescence to enable registration of the entry of 

calcium into the nerve endings in response to low-frequency stimulation of the motor nerve". 

There is no data within this manuscript or referenced which speaks to this claim. A 

percentage of labelled synapses or a readout of effective stimulation tests per region tested 

would be necessary. 

A similar loading method is used for various preparations and is described in the literature, 

cite to which we give. For example, Suzuki, S. et al. 2000 described: 

«When loading of the Ca2+ indicator was successful, all the terminals near the main nerve 

bundle innervating the muscle fluoresced strongly enough for [Ca2+]i to be measured, 

although the terminals far from the main bundle fluoresced only weakly, and were not used 

to measure [Ca2+]i.» 

The number of stained terminals may vary depending on the loading conditions (length of 

the nerve stump, the amount of dye trapped in the nerve, the number of synapses close to 

the main trunk, etc.) We noted this in the discussion. 

See line 434-437: 

“Depending on the length of the nerve segment remained after the cutting, the speed of dye loading 

and the number of loaded terminals may vary. It was possible to even further reduce the incubation 

time in dye solution for shorter nerve stumps. A similar method is described for the loading of fly 

synapses18, 19” 



 It is difficult to estimate the percentage of loaded synapses. Because only loaded synapses 

can be visualized. Unloaded ones need to be dyed separately and counted for each prep. 

This is the subject of a separate study. 

 

 

Minor Concerns: 

 
Usage of the abbreviation LSCM on line 69 is presented without first informing the audience 
of what this stands for. 
 

Answer 
 

Thank you. We have added a transcript of the abbreviation to the text 

See line 94: 

 
“This article presents a method for increasing the temporal resolution of signals recorded with the Laser 

Scanning Confocal Microscopy (LSCM) while maintaining the spatial resolution37.” 

 
Preparing the dye loading solution: The value of 14uL in step 1.2.2 seems like a very small 
volume to dissolve 500ug of dye in, and would lead to an incredibly high concentration of 
dye if it all can dissolve in this amount. Please double check this value. 
Similarly in step 1.2.4, dyes are typically used in the uM range rather than the mM range so 
this value seems high. How much total of this dye liquid is typically made at a time, the 
authors later state 3cm in a syringe per muscle preparation. 
 

Answer 
 
There was no dilution error. We have added a concentration value of 30mM.  This is basic 

concentration. We used this concentration when loading the nerve endings of the frog ( 

Samigullin, DV, et. All Loading a Calcium Dye into Frog Nerve Endings Through the Nerve 

Stump: Calcium Transient Registration in the Frog Neuromuscular Junction. Journal of 

Visualized Experiments. 2017 (125) , e55122, doi: 10.3791 / 55122 (2017).). A similar 

concentration is used by other researchers when loading the dye in a similar way. For 

example: 

"Briefly, the nerve was immersed in a drop of 30 mM dye dissolved in distilled water for 6-8 

h at room temperature." (Luo, F., Dittrich, M., Cho, S., Stiles, JR, Meriney, SD Transmitter 

release is evoked with low probability predominately by calcium flux through single channel 

openings at the frog neuromuscular junction.Journal of Neurophysiology. 113 ( 7), 2480–

2489, doi: 10.1152 / jn.00879.2014 (2015).) 

Then we diluted the dye to 1 mM and used this concentration as a working concentration 

when applying the dye to the stump. 

Yes, dyes are usually used in μM concentrations. But in our case, after the dye loading 

solution enters the loading pipette and the nerve, it is diluted with a ringer, etc. and already 



in the peripheral nerves, the concentration will be about 40-150 μM (Suzuki, S. et al. Ca2 + 

dynamics at the frog motor nerve terminal. Pflugers Archiv: European journal of physiology. 

440 (3), 351–65, doi: 10.1007 / s004240000278 (2000).). We have added this information to 

the introduction. 

See line :65-67: 

“Although this method does not provide an accurate evaluation of the concentration of the dye in the 

target cell, it can be estimated approximately by comparing the level of fluorescence of the cells at rest 

in solutions with a known concentration of calcium21.” 

 

Step 2.1: References a previous protocol for the dissection of the LAL muscle. Following 

this dissection, when the tissue is fixed in step 2.1.1, does it need to be entirely submerged 

in Ringers solution? Similarly, in step 2.21 how much Ringers solution should be added (or 

should the sample be submerged) to prevent it from drying out over the 2hr incubation 

period? Should the entire setup be covered to prevent evaporation? 

Answer 
 
Thanks for the comment. We made a text correction and added information 

See line 136-140: 

“2.1.1. Fix the tissue slightly stretched (no more than 30% from initial length) in the elastomer-coated 

Petri dish with fine stainless still pins and add Ringer’s solution until the muscle is fully covered.  

Note: The petri dish was pre-filled with elastomer according to the manufacturer's instructions supplied. 

(see the Table of Materials).” 

See line 181-184: 

 “2.1.1. Fix the tissue slightly stretched (no more than 30% from initial length) in the elastomer-coated 

Petri dish with fine stainless still pins and add Ringer’s solution until the muscle is fully covered.  

Note: The petri dish was pre-filled with elastomer according to the manufacturer's instructions supplied. 

(see the Table of Materials).” 

 

 

 

Steps 2.2-2.5 seem like they should be a single step with sub-steps, for the preparation of 

the pulled "filling pipette". 

 

Answer 
 
Thanks for the comment. We made a text correction and added information 

See line 142-151.  



 

It is recommended that the authors include a representative figure or definitely film steps 

2.6- 2.13. There is no representative figure for this portion of the protocol at this time, and 

without visual aids it would be quite challenging for a novice experimenter to complete 

these steps correctly. 

Answer 
 

Thanks for the comment, of course, these stages will be given special attention when 

preparing the video. 

 

 

The phrasing "to stimulate the nerve" is confusing in step 3.3, as this is not the step when 

stimulation is applied. According to the protocol the stimulation unit is not set until step 3.11 

and not applied until step 3.14. Similarly, the phrase "observe muscular contractions under 

the microscope" in step 3.6 should be followed with the phrase "See section 3.11-3.16 for 

stimulation conditions and recording", as no stimulation is yet applied at this step. 

 

Answer 
 
Thanks for the comment. We made a text correction and added information 

See line 205 : 

“3.3. Install suction electrode which will be used to stimulate the nerve.” 

 See line 216-217: 

“ 3.6. Plug in stimulating electrode to an electric stimulator and make sure occurring muscular 

contractions after stimuli. See section 3.10-3.15 for stimulation conditions and recording.” 

 

 

Sections 3.9- 3.10 seem like they should be a single step with sub-steps, for the "setup of 

imaging parameters". 

 

Answer 
 

Thank you for your comment. We made corrections and took into account your comments. 

See line 229-253 

 

Step 3.7: There is no mention as to why b-turbocurarine is included in the Ringers solution. 

Also, there is no representation of the perfusion system included in the Figure 1 description 

of the overall experimental setup. 



” 

Answer 
 

Thank you for your comment. We add perfusion system in the Figure 1 . We made 

corrections and took into account your comments. 

See line 219-224 

“3.7 Fill up the perfusion system with the Ringer’s solution with d-tubocurarine (10 µM).  

Note: This solution helps to prevent muscular contractions. D-tubocurarine or alpha-bungarotoxin - 

specific blockers of nicotinic acetylcholine receptors on postsynaptic membrane, would completely or 

partially block muscle contractions49. Also for preventing muscular contractions specific blockers of 

postsynaptic sodium channels - µ-conotoxin GIIIB could be used50.” 

 

 

3.10: There are no details on how to initiate or use live mode given in this step. The 

associated Figure (Figure 2) is very pixelated and does not have good resolution. As this 

protocol is promoting a high-quality resolution using these parameters, a better 

representative image should be included with this step. 

 

Answer 

We've added information about enabling live mode. 

See line 251-252  

“3.9.2. Live mode helps to get a preview of nerve terminals loaded with the dye.  

Press the "Live mode" button to switch to Live mode” 

 

Figure 2 is presented for a representative purpose in order to show what the peripheral nerve endings 

look like loaded with calcium dye according to the proposed method. It is made with a resolution of 512 

by 512 pixels, which is sufficient for most applications. This photograph was taken with a confocal 

microscope. Using confocal filtration, and confocal scanning of the specimen. This ensures the fixation 

of the fluorescent signal from a small volume of the preparation during scanning at each separate 

moment of scanning time. And this provides a higher resolution compared to shooting with fluorescent 

cameras and lighting the entire sample. 

  As for the protocol, the concept of high-quality resolution is primarily related to the temporal 

parameters (high temporal resolution) in the application of confocal microscopy and the comparison of 

these parameters with high-speed cameras. On high-speed cameras that provide high-speed shooting, 

the resolution is 80 * 80 pixels, which is much lower than what confocal microscopy can offer. 

 
Sections 4.1- 4.11 should be an independent "video processing" section than steps 4.12-
4.24 which is "video analysis". This is particularly evident since there is a paragraph titled 



"next step", lines 257-259 which state that the steps following are a separate process. 

 
Answer 
 
Thank you for your comment. we have corrected the text according to your 

recommendations 

 

Step 4.7 The number of frames (20) indicated in this step, does not match with the number 

of 2ms shifts indicated in step 3.16 (26). 

Answer 
 

 

The number of frames during video recording depends on the duration of the signal 

(calcium transient). In fact, this is the number of frames k multiplied by the time required to 

form one frame. Since one frame (frame) is formed in 52 ms, it is necessary to choose k = 

20 so that the duration of the video recording is 52 ms * 20 = 1040 ms, or about one 

second. The number of steps, in turn, depends on what kind of temporal resolution we want 

to get. Since we need a temporal resolution of 2 ms to adequately estimate the rise time, 

we need to take the number of repeated records n = 26 or n-1 = 25 steps, if we do not take 

into account the first record. the number of recording iterations is calculated by the formula 

n = T / t = 52ms / 2ms = 26, where T is the time required for the confocal microscope to 

form one frame, t is the required time resolution. 

We have added this information to the description for Figure 3. 

See line 396-411: 

“Figure 3: Scheme for compiling a high resolution video file (2 ms on frame) from original video files with 

a low temporal resolution (52 ms on frame). The original video files and the corresponding signals are 

colored in black, magenta and green. The compiled video file and the resulting signal are colored red. 

The scheme on the right, line by line, shows the video images obtained with a confocal microscope. On 

the left, the corresponding signals of fluorescence change from the selected ROI. The topmost line is 

formed frame by frame from the received frames according to the scheme. The result is a video image 

consisting of the entire array of frames so that there is a delay time is 2 ms between frames instead of 

52 ms. Each line corresponds to an offset of the stimulation signal by (n-1)*t, where t - time shift (2 ms), 

n - number of shift iterations. k- the number of frames in the original video files (2nd-4th lines) depends 

on the duration of the recorded signal. In this case, in order to register a signal with a duration of 1 

second, it is necessary to select k = 20 (52 ms * 20 = 1040 ms), t0 is the required delay before 

stimulation. To calculate the number of shift iterations n, the initial temporal resolution between frames 

(52ms) must be divided by the required one (2ms). In this case, n = 26, which corresponds to 26 

registered sweeps. As a result of the performed manipulations, a video image consisting of n * k = 520 

frames is obtained.” 

 

Line259: The directive: "Click Image >adjust> brightness/contrast" needs more detail and 

explanation. What are these values adjusted to, and is it applied uniformly to all images? 



Answer 
 
Thank you for your comment. we have corrected the text according to your 

recommendations 

See line 355-366 

“5.5. To improve image visualization click Image > adjust > brightness/contrast > auto. This step will not 

affect data”. 

 

Step 4.20 should denote at the end that this step has now performed actions of background 

subtraction and recording of adjusted raw fluorescence values for the selected ROI. 

Answer 
 
Thank you for your comment. we have corrected the text according to your 

recommendations 

See line 355-357 

5.12. Divide signal values by average offset value. After this step, the signal does not contain the 

contribution of background and raw fluorescence to the amplitude values for the selected ROI. 

 
 
Step 4.21 should indicate that this step is the establishment of the F0 value that will be used 
in subsequent calculations. 
 

Answer 
 
Thank you for your comment. we have corrected the text according to your 

recommendations 

See line 351-353  

“5.11. Average offset of signals  

Note: Use the corresponding points depending on delay time before stimulation. This step is the 

establishment of the F0 value that will be used in subsequent calculations. “ 

 

 

 

Figure 4: Details of how this experiment were performed are required in the Figure legend. 

The image itself needs additional information, such as the overall magnitude of the deltaF/F 

reached, and the overall duration of the recording. 

Answer 
 



We have added information to the Figure and in the Figure legend 

See Figures, 1,3,4 

See line 389-419: 

“Figure 1: The schematic of the experimental setup. 1: Laser Scanning Confocal Microscope (LSCM). 2: 

Synchronization module of LSCM (trigger box). 3: Stimulator. 4: Isolation unit. 5: The biological sample. 

6: Suction electrode for electrical stimulation of nerve. 7: Perfusion systems a-perfusate reservoir, b-

dropper, c-flow regulator, d-vacuum flask. Arrows point to the direction of propagation of synchronizing 

pulse. 

 

Figure 2: Mouse nerve and terminals loaded with the Ca2+ indicator. 

 

Figure 3: Scheme for compiling a high resolution video file (2 ms on frame) from original video files with 

a low temporal resolution (52 ms on frame). The original video files and the corresponding signals are 

colored in black, magenta and green. The compiled video file and the resulting signal are colored red. 

The scheme on the right, line by line, shows the video images obtained with a confocal microscope. On 

the left, the corresponding signals of fluorescence change from the selected ROI. The topmost line is 

formed frame by frame from the received frames according to the scheme. The result is a video image 

consisting of the entire array of frames so that there is a delay time is 2 ms between frames instead of 

52 ms. Each line corresponds to an offset of the stimulation signal by (n-1)*t, where t - time shift (2 ms), 

n - number of shift iterations. k- the number of frames in the original video files (2nd-4th lines) depends 

on the duration of the recorded signal. In this case, in order to register a signal with a duration of 1 

second, it is necessary to select k = 20 (52 ms * 20 = 1040 ms), t0 is the required delay before 

stimulation. To calculate the number of shift iterations n, the initial temporal resolution between frames 

(52ms) must be divided by the required one (2ms). In this case, n = 26, which corresponds to 26 

registered sweeps. As a result of the performed manipulations, a video image consisting of n * k = 520 

frames is obtained. 

 

Figure 4: Representative trace of calcium signal from one experiment. Some important parameters of 

signal, such as mean amplitude (MA), rise time (RT) and decay time (DecT), and its projections on axes 

are indicated. MA – calculated by averaging points at peak, colored in green. RT – the time while 

amplitude rise up from 20 to 80% and calculated as difference between projections on x axis, colored in 

blue. DecT– the time when amplitude decrease at e times and calculated as difference between 

projections on x axis colored in red 

” 

 

4.24 More details are needed in this bullet point and in Table 1. Is the value presented the 

peak deltaF/F value? The authors state in the representative results that they "analyzed 

amplitude and calculated time parameters of recovered signals", however there is no 

description in the manuscript text or in the figure legend as to how this was done. 

It is rather unclear as to how the authors arrive at their final "peak" fluorescence value. The 



authors just have a listing of end output results for Table 1, rather than a visual illustration of 

how the calculations were performed. 

Answer 
 

We have added information to the Figure4 and in the Figure4 legend 

See Figure 4 and line 414-419: 

“Figure 4: Representative trace of calcium signal from one experiment. Some important 

parameters of signal, such as mean amplitude (MA), rise time (RT) and decay time (DecT), 

and its projections on axes are indicated. MA – calculated by averaging points at peak, 

colored in green. RT – the time while amplitude rise up from 20 to 80% and calculated as 

difference between projections on x axis, colored in blue. DecT– the time when amplitude 

decrease at e times and calculated as difference between projections on x axis colored in 

red” 

 

In line 334-335 of the discussion, the authors say that "it was possible to even further 

reduce the incubation time for shorter nerve stumps". Could the authors please include a 

specific example or further details on this? 

Answer 
 
Thank you for your comment. we have corrected the text according to your 

recommendations 

See line  
 
In lines 344-346 the authors stress the importance of the suction electrode. It would be 
advantageous to point this out as a note in the protocol section as a particular point to pay 
close attention to. 

 
Answer 
 
Thank you for your comment. we have corrected the text according to your 

recommendations 

See line 435-438 

“Depending on the length of the nerve segment remained after the cutting, the speed of dye loading 

and the number of loaded terminals may vary. It was possible to even further reduce the incubation 

time in dye solution for shorter nerve stumps.” 

 

Reviewer #3: 

Manuscript Summary: 

In this manuscript, N. Zhilyakov et al. report on two different protocols for characterizing 

calcium transients in mouse neuromuscular junctions. The first one is about the labeling of 

the neurons to be characterized. Specifically, they describe how to perform the loading of a 

calcium-sensitive dye through the nerve stump into the nerve endings of a mouse. The 

second protocol is about the imaging of the calcium transients using confocal microscopy. 



 

Major Concerns: 

In my opinion, the information in the manuscript is insufficient to reproduce the experiments 

described. Further information is needed, as described below. 

 

1) A list of all the materials needed should be specified before describing the protocol. 

 

Answer 
 

According to the rules of the journal, the list with materials is presented in a special table 

Table of Materials.  It is downloaded separately. 

 

2) The steps for the dye-loading procedure are not clear. For instance: 

- Line 92: The dye is not specified. 

Answer 
 

According to the rules of the magazine, the names of firms and commercial names of 

materials cannot be used in the text. 

«JoVE cannot publish manuscripts containing commercial language. This includes 

trademark symbols (™), registered symbols (®), and company names before an instrument 

or reagent. Please remove all commercial language from your manuscript and use generic 

terms instead. All commercial products should be sufficiently referenced in the Table of 

Materials».  

The specify of the dye is presented in Table of Materials 

Oregon Green 488 BAPTA-1 pentapotassium salt, Molecular Probes, USA, O6806500 500 

μg 

 

- Line 116: "Break off the tip of the electrode after score of the taper with an abrasive." 

Which electrode are the authors referring to? 

Answer 
 

This refers to a micropipette, the manufacture of which was described in paragraph 2.2. 

We changed the text to make it clearer 

See line 148-149 

“2.2.2 Break off the tip of the micropipette after scoreing of the taper with an abrasive. Leave the tip 

open to about 100 microns in diameter. “ 



  

- Line 137: "Remove the suction tubing from the blunt end of the Filling Pipette." Which 

suction tubing? 

Answer 
 

Meaning the tube that was put on for suction of the nerve into the micropipette 
See step 2.3 (line 154-155). “Put on silicone tube on the back of the Filling Pipette from the one 

side, and on syringe without needle from the other”. 

 
All these steps will be presented in detail in the video. 
 

 
- Line 139: "Draw some amount of the dye loading solution (~3 cm) using a syringe with a 

long filament." What type of filament? 

- A schematic representation of the different steps is needed. 

 

Answer  
We've added some text for a more complete explanation, and the video will show you how 

to make filament. 

See line 171-174: 

“2.9. Draw some amount of the dye loading solution (~0.3 µl) using a syringe with a long filament. This 

volume corresponds to approximately 3 cm of liquid filling the filament. 

Note: Initially it is necessary to make a filament from a pipette tip with a volume of 10 µl by pulling on 

the fire using an alcohol lamp or a gas burner”. 

 

3) More information is needed for the video capture with the confocal microscopy section. 

- The confocal microscope used is equipped with a system for electrophysiology. No details 

of such a system are provided. 

Answer  
 
Registration of the video-images was accomplished in the regime “Electrophysiology” set-
up on the LSCM. In this regime, at the time point when image is captured, a synchronizing 
pulse is sent to the trigger box. This in turn triggers stimulation pulse, eliciting AP 
generation in the preparation. 
We have added clarification to the text 

See line 233-236: 

“In Leica Microsystems LAS AF choose Electrophysiology;  

Note: In this mode, at the time point when image is captured, a synchronizing pulse is sent to stimulator 

with help the trigger box. This eliciting action potential generation in the preparation (sее Figure 1 and 

Stimulation unite).” 



- Line 166: "Use suction electrode to stimulate the nerve." Which suction electrode? 

Further in the text there is an explanation and a reference to the article describing the 

construction of the suction electrode 

See line 205-208 

“3.3. Install suction electrode which will be used to stimulate the nerve. 

Note: Construction of the electrode is similar to what was published in the paper by Kazakov et. al., 

2015. Place and fix by wax the electrode beside the bath. Move the tip close to the nerve stump and 

aspirate it into the electrode. “ 

 

 

- Line 182: "Switch on the pump and start perfusion of the preparation with the Ringer's 

solution with d-tubocurarine." Which concentration of d-tubocurarine is needed? 

Answer 

The previous sentence indicates the concentration of d-tubocurarine 

See line  219: 

“3.7 Fill up the perfusion system with the Ringer’s solution with d-tubocurarine (10 µM).  

 

- Line 208: "In our work, we used the programmable stimulator described in in the paper by 

Land et al.". Details of the stimulator should be provided in the current protocol. 

Answer 

 

We've added a description of the stimulation unite 

See line 255-272 

“3.10 Stimulation unit  

In this work the stimulator described in the article by Land et al. 51 was used. This device allows set 

temporal parameters of stimulation via the MatLab software. Create file, copy and paste the code from 

mentioned article to MatLab code window, then save. Click Run, a window with stimulation parameters 

will appear. Set delay time and duration of the stimulus. The delay determines temporal resolution of 

the reconstituted fluorescent signal. Electric pulse of 0.2 ms duration is delayed, then sent to the 

isolation unit. The latter forms the amplitude and polarity of the stimulating pulse and electrically 

isolates the biological object from the recording equipment. To stimulate the nerve, the supramaximal 

amplitude of the stimulating impulse is selected (25% –50% greater than the maximum stimulation 

intensity necessary to activate all the nerve fibers).  

Presented method based on special algorithm for recordings of single fast fluorescent signals using 

LSCM with the minimized sweep. At each step of developed algorithm, recorded fluorescent signal is 



shifted from the previous one by time interval which is shorter than the microscope sweep. The value of 

time shifts determines temporal resolution of required signal. Number of steps (shifts) in algorithm is 

depends on required temporal resolution and origin one. With this method of registration, the 

stimulation of the preparation is carried out with a frequency of 0.25 Hz.” 

 

4) As it is written, the protocol for data analysis is difficult to follow. 

- Line 250: Why is 20 frames mentioned, when the actual number of acquisitions is 26? The 

description of the steps for processing images with ImageJ does not yield the results 

described in Figure 3. 

 

Answer 

We have add description to the to Fig. 3 and we hope that the description of the protocol 

has become clearer 

See line 397-412 

“Figure 3: Scheme for compiling a high resolution video file (2 ms on frame) from original video files 

with a low temporal resolution (52 ms on frame). The original video files and the corresponding signals 

are colored in black, magenta and green. The compiled video file and the resulting signal are colored 

red. The scheme on the right, line by line, shows the video images obtained with a confocal microscope. 

On the left, the corresponding signals of fluorescence change from the selected ROI. The topmost line is 

formed frame by frame from the received frames according to the scheme. The result is a video image 

consisting of the entire array of frames so that there is a delay time is 2 ms between frames instead of 

52 ms. Each line corresponds to an offset of the stimulation signal by (n-1)*t, where t - time shift (2 ms), 

n - number of shift iterations. k- the number of frames in the original video files (2nd-4th lines) depends 

on the duration of the recorded signal. In this case, in order to register a signal with a duration of 1 

second, it is necessary to select k = 20 (52 ms * 20 = 1040 ms), t0 is the required delay before 

stimulation. To calculate the number of shift iterations n, the initial temporal resolution between frames 

(52ms) must be divided by the required one (2ms). In this case, n = 26, which corresponds to 26 

registered sweeps. As a result of the performed manipulations, a video image consisting of n * k = 520 

frames is obtained.” 

 
5) In the Discussion section, the authors should explain how to implement the inverse 
convolution of images. 
The authors also state that "One of the limitations of current method is that the original 
signals must have little variability in parameters and have a good reproducibility". The 
reproducibility of the signal should be properly characterized by recording calcium 
transients obtained after identical stimulation conditions. 
 

Answer 

 
Application of our method assumes that underlying events triggered by external stimulation 
are reputable and reproducible in magnitude and kinetics, so that one can use time 
increments in subsequent stimulation cycles to reconstitute high-resolution signal. So, this 
technique cannot be used to describe differences between individual events sampled. The 
events sampled must be uniform in magnitude and kinetics. Our group has devoted many 



years to the study of calcium transient. And our early observations and data from other 
authors suggest that calcium transient meet this condition. The figure below shows, for 
example, 18 realizations of signals recorded by a speed camera.

 
 

 

 

6) The authors state that Line 59: "However, their main disadvantage is low resolution, 

limited by the size of the sensitive elements of the matrix". The problem of using cameras 

for characterizing calcium transients is not due to their reduced number of pixels or low 

spatial resolution. It is their low temporal resolution. This is explained in: M. Duocastella et 

al., Acousto-optic systems for advanced microscopy, Journal of Physics: Photonics, 3, 

012004 (2021). 

Answer 

 

Cameras capable of registering fast and low intensity processes exist we have added 

information and a link to the introduction. But the problem is that calcium transients in 

response to rare stimulation are fast and low in intensity. So cameras capable of registering 

such low-intensity processes should be not only high-speed, but also have sufficient 

sensitivity. So those cameras that fit have a low-resolution monochrome sensor. 

For example, the camera, which is at the disposal of the team of authors 

http://www.redshirtimaging.com/redshirt_neuro/hardware_neuroccdsm.htm, 

 allows to register calcium transients with a time resolution of 2 ms and has a matrix of 80 to 

80 pixels. 

7) Similarly, the problem of confocal microscopy is not the low scanning speed, as the 

authors mention in Line 63. Note that the authors use a microscope capable of scanning at 

1400 Hz! The problem is the sequential nature of confocal microscopes and the need for 

point-by-point scanning. More details on this topic can be found in: J. Mertz, Optical 

sectioning microscopy with planar or structured illumination, Nature Methods, 8, 811-819 

(2011) 
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http://www.redshirtimaging.com/redshirt_neuro/hardware_neuroccdsm.htm


Answer 

Thank you very much for your comment and helpful information. We have corrected this 

phrase and added a cite 

See line 82-84 

“But it should be kept in mind the fact that confocal microscopy has a high scanning speed in line scan 

mode, but there are still significant limitations on the speed of recordings of fast processes when 

building a spatial image33” 

 

For information 

The frequency 1400 Hz characterizes scanning along one X axis. The transition to the next 

scan line in the XY scanning mode in the microscope takes a long time and apparently 

depends on the speed of the mirrors. We carried out the corresponding measurements 

during the preparation of the publication (A. Y. Arkhipov, E. F. Khaziev, A. I. Skorinkin, E. A. 

Bukharaeva, and D. V. Samigullin, Microscopy and Microanalysis (2020).) And they are 

included in the supplementary materials: 

«For the window of 512 by 64 pixels and the frequency of scanning equal to 1400 Hz, the 

LSCM required 44 ms to generate a single frame (these parameters coincide with the 

scanning parameters in the biological experiments described in paper). Within this time 

span, 22.75 ms are required for scanning process itself and then, the rest 21.5 ms the laser 

is shut down. The latter corresponds to the time required to return the mirror of the Y axis 

displacement from the ending to the starting point. At the bottom of Fig. E the signals are 

presented that describe generation of lines by the laser during scanning. The laser requires 

234 us to generate the line during displacement along the X axis. After that the laser is shut 

down for 122 us. This interval corresponds to the time required for transition to a new line 

along the Y axis. This means, that generation of a frame requires 22.78 ms ((=122 us  + 

234us )*64); the rest of the time (21.5 ms ) is spent for return of the laser beam to the 

starting point of scanning. The parameters measured correspond to the parameters of 

scanning used in our experiments described in this paper. They can vary depending on the 

setting of scanning parameters of the microscope, such as scanning frequency, the size of 

scanning area, the regime of scanning, zooming etc.» 

 

  

 

Reviewer #4: 

Manuscript Summary: 

This manuscript presents an approach for loading fluorescent dyes into peripheral synapses 

of mammals and a method for recording fast fluorescent calcium signals via confocal 

microscopy. The manuscript is well-written and makes an important contribution. However, 

some deficiencies are noted (described below). Authors are encouraged to addressed all 

the comments to improve the presentation. 

 



Major Concerns: 

Introduction: 

1. This section will benefit from including more specific technical details. For example, "fast 

process" does not say much. Please specifically mention biological timescales of interest 

and how current imaging modalities match up to thee timescales. Same comment holds for 

spatial resolution. 

Answer 
 
We have add information in introduction 

 see Lines 69-92: 

“Calcium entry during the depolarizing phase of the action potential is a fast process, especially 

in the neuromuscular junction; therefore, for its registration, appropriate equipment is required1. 

Recent study using a voltage-sensitive fluorescent dye, demonstrated that the duration of the action 

potential in the peripheral synapse of a mouse is 300 μs approximately22. Calcium transient, evaluated 

using calcium-sensitive dyes in the peripheral synapses of the frog, has a longer duration: the rise time is 

about 2-6 ms and the decay time is about 30-90 ms, depending on the calcium dye used23, 24. To 

measure fast processes with the help of fluorescent dyes, CCD or CMOS cameras are generally used, 

with the fast and sensitive CCD matrices. However, these cameras have a disadvantage which is low 

resolution, limited by the size of the sensitive elements of the matrix25–28. The fastest cameras with 

sufficient sensitivity to record both action potentials and calcium transients in response to rare 

stimulation of cells have a scanning frequency of 2000 Hz, and a matrix with a dimension of 80 * 8029. To 

obtain signals with a higher spatial resolution, confocal microscopy is used, especially if it is necessary to 

assess some volumetric changes in the signal 30–32. But it should be kept in mind the fact that confocal 

microscopy has a high scanning speed in line scan mode, but there are still significant limitations on the 

speed of recordings of fast processes when building a spatial image33. There are confocal microscopes 

based on rotating Nipkow disks (slit-scanning microscopy) and Multipoint-Array Scanners, which have a 

higher scanning speed. At the same time, they are inferior to the classical confocal microscopes in 

confocal image filtering (pinholes crosstalk for microscopes with a Nipkow disk)32, 34, 35. Confocal imaging 

with resonance scanning can also provide the high spatial–temporal resolution required for high 

temporal measurements36. However, take into account that the registration of weak fluorescent 

responses at a high scanning speed when using resonance scanners, requires highly sensitive detectors, 

such as hybrid detectors.36.”  

 

2. Please include background on the biological importance of this work and its clinical 

implications. The rationale for measuring calcium is not fully described. 

Answer 
 
The first paragraph of the introduction focuses on the importance of studying calcium 

signaling in biology. We have added additional information 

See Lines 125-130: 

“The problem of measuring fast calcium waves in excitable cells is one of the most important and 

challenging in the field of studying signal transmission in the central and peripheral nervous systems. 

Calcium ions play an important role in the triggering neurotransmitter release, synaptic plasticity and 



modulation of the activity of various intracellular proteins1–5. Studying calcium signaling is also 

important for finding ways to treat neurodegenerative diseases6. To measure changes in the calcium 

levels, fluorescent calcium-sensitive dyes are commonly used, and changes in their fluorescence level 

are analyzed7–9” 

 

3. I agree that 3D volumetric imaging without compromising temporal resolution is 

challenging. However, this point needs to be elaborated with suitable examples and a 

comparison of other imaging techniques. Since this is a methods paper, a short table 

identifying specific spatio-temporal challenges issues/associated with imaging calcium 

oscillations and the limitations of current imaging approaches for the same would be 

appropriate.   

Answer 
The main aim of this research is devoted to a topic: loading a calcium dye and a description 

of the method for registering calcium transinet using LCSM methods with high temporal 

resolution. We have added information in the introduction provides on comparing methods 

and comparing the main disadvantages and advantages. A more detailed comparison of the 

methods requires a separate study, and many review articles are devoted to this, which we 

refer to in this work. Including with tables of comparison of methods. For example, Bullen A. 

et. all (Bullen A, Patel SS, Saggau P. High-speed, random-access fluorescence 

microscopy: I. High-resolution optical recording with voltage-sensitive dyes and ion 

indicators. Biophys J. 1997; 73 (1): 477-491 . doi: 10.1016 / S0006-3495 (97) 78086-X) 

4. In addition to multipoint array scanner, confocal imaging with resonance scanning can 

also provide the necessary spatio-temporal resolution required for such measurements. 

This can be mentioned in the introduction. One recent 

reference: https://doi.org/10.1002/bit.27465 

Answer 
 

Thanks for the information, we've added a text and cite in introduction 
 
See line 88-92: 

“Confocal imaging with resonance scanning can also provide the high spatial–temporal 

resolution required for high temporal measurements36. However, take into account that the registration 

of weak fluorescent responses at a high scanning speed when using resonance scanners, requires highly 

sensitive detectors, such as hybrid detectors.36. “ 

 
 
5. Please clearly but briefly state at the end of the introduction how your approach 
overcomes the spatio-temporal limitations discussed with current imaging modalities. 

 
Answer 

 

See line 93-98 

https://doi.org/10.1002/bit.27465


“This article presents a method for increasing the temporal resolution of signals recorded with 

the Laser Scanning Confocal Microscopy (LSCM) while maintaining the spatial resolution37. The current 

method is a further development of the methods described early and transferred to the LSCM 

platform38–40. This approach does not require changes in the microscope hardware and is based on the 

application of an algorithm for recording periodically evoked fluorescent signals with a time shift relative 

to the moment of stimulation.” 

 

 

Methods: 

1. Although appropriate references are given to previous work, this paper needs to stand on 

its own. So, where appropriate, please provide all the details in the protocols for someone 

to replicate the data based on this paper alone. 

Answer 
 

Since the article actually describes two protocols: dye loading and registration with signal 

processing, in order not to overload the material, we omitted the part devoted to dissection, 

based on the fact that this journal has a separate publication with a video on how to dissect 

this particular preparation - LAL (Wright, M., Kim, A., Son, Y.-J. Subcutaneous 

Administration of Muscarinic Antagonists and Triple-Immunostaining of the Levator Auris 

Longus Muscle in Mice. Journal of Visualized Experiments. (55), e3124, doi: 10.3791 / 3124 

(2011); Burke, SRA, Reed, EJ, Romer, SH, Voss, AA Levator Auris Longus Preparation for 

Examination of Mammalian Neuromuscular Transmission Under Voltage Clamp 

Conditions.Journal of Visualized Experiments. 2018 (135), e57482, doi : 10.3791 / 57482 

(2018)). The rest of the necessary steps are presented in the protocol and will be presented 

in the video. 

 

2. What is the dye being used? It's not mentioned in main text but only in the table of 

materials. 

Answer 
 

According to the rules of the magazine, the names of firms and commercial names of 

materials cannot be used in the text. 

«JoVE cannot publish manuscripts containing commercial language. This includes 

trademark symbols (™), registered symbols (®), and company names before an instrument 

or reagent. Please remove all commercial language from your manuscript and use generic 

terms instead. All commercial products should be sufficiently referenced in the Table of 

Materials».  

The specify of the dye is presented in Table of Materials 

Oregon Green 488 BAPTA-1 pentapotassium salt, Molecular Probes, USA, O6806500 500 

μg 



 

3. Please provide a real-time photograph or a detailed technical schematic of the imaging 

set-up, imaging chamber and perfusion set-up described in steps 3.1 to 3.9 and mark all the 

parts to match with the description in the text. Replace Figure 1 with this. The current Figure 

1 does not add much value to the manuscript. 

Answer 
 

We have added information to the scheme. The diagram allows you to accurately separate 
the main components of the setup. Also the diagram shows the connection and direction of 
the sync pulse. It doesn't work in the photo. The real components of the installation will be 
presented in the video. 
 
4. Section 3.11: please provide more details of the approach used to improve temporal 
resolution. For example, how long is the imaging conducted and how often are images 
captured? 
 

Answer 
 
Our registration method is described in detail in the article “Arkhipov, A.Y., Khaziev, E.F., 

Skorinkin, A.I., Bukharaeva, E.A., Samigullin, D. V. Enhancement of the Temporal 

Resolution of Fluorescent Signals Acquired by the Confocal Microscope. Microscopy and 

Microanalysis. 26 (2), 204-210, doi: 10.1017 / S1431927620000148 (2020) ". Which we are 

referring to in the post test. In this publication (according to the subject of the journal), we 

focus on the signal registration protocol using this technique. The method is illustrated in 

Figure 3. We have written a more detailed description in the caption to this figure. And we 

also correct 3.10. 

According to the updated description to Fig. 3, it takes about 1 min to restore the signal with 

the required time resolution of 2 ms. The time is made up of the time required to generate 

26 videos with a low temporal resolution (52 ms per frame), each of which has a duration of 

1040 ms and consists of 20 frames, and the time required to change the time delay 

between recordings (it depends on the characteristics of the stimulator). in our case, the 

frequency of stimulation of the drug depends on the frequency of the formation of the video 

file and is 0.25 Hz or one stimulus in 4 s 

See line 397-412 

“Figure 3: Scheme for compiling a high resolution video file (2 ms on frame) from original video files 

with a low temporal resolution (52 ms on frame). The original video files and the corresponding signals 

are colored in black, magenta and green. The compiled video file and the resulting signal are colored 

red. The scheme on the right, line by line, shows the video images obtained with a confocal microscope. 

On the left, the corresponding signals of fluorescence change from the selected ROI. The topmost line is 

formed frame by frame from the received frames according to the scheme. The result is a video image 

consisting of the entire array of frames so that there is a delay time is 2 ms between frames instead of 

52 ms. Each line corresponds to an offset of the stimulation signal by (n-1)*t, where t - time shift (2 ms), 

n - number of shift iterations. k- the number of frames in the original video files (2nd-4th lines) depends 

on the duration of the recorded signal. In this case, in order to register a signal with a duration of 1 

second, it is necessary to select k = 20 (52 ms * 20 = 1040 ms), t0 is the required delay before 

stimulation. To calculate the number of shift iterations n, the initial temporal resolution between frames 



(52ms) must be divided by the required one (2ms). In this case, n = 26, which corresponds to 26 

registered sweeps. As a result of the performed manipulations, a video image consisting of n * k = 520 

frames is obtained.” 

 

Results: 
1. Fig.4: Please report multiple calcium transients over a reasonable time period to show 
evidence of temporally varying calcium oscillations. Please quantify and report inter-spike 
distance. 
 

Answer 
 
 
 
Application of our method assumes that underlying events triggered by external stimulation 
are reputable and reproducible in magnitude and kinetics, so that one can use time 
increments in subsequent stimulation cycles to reconstitute high-resolution signal. So, this 
technique cannot be used to describe differences between individual events sampled. The 
events sampled must be uniform in magnitude and kinetics. Our group has devoted many 
years to the study of calcium transient. And our early observations and data from other 
authors suggest that calcium transient meet this condition. The figure below shows, for 
example, 18 realizations of signals recorded by a speed camera . 

 
 

We have added information about the frequency of stimulation to the manuscript. 

See line 271-271  

“With this method of registration, the stimulation of the preparation is carried out with a frequency of 

0.25 Hz.” 

 

 

Discussion: 

1. High spatial and temporal resolution is mentioned a few times. However, the terms "high" 

and "low" are subjective. Please discuss the biological implications of your results and also 
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where this spatio-temporal resolution may be considered sufficient and in what 

(biological/clinical) scenarios the current resolution might not be sufficient. 

Answer 
 
Thanks for the comment. We have added this  information to the discussion.  

See line 461-466 

“In this study, to record the calcium transient, the original registration method was used via LSCM, 

described thoroughly in the article by Arkhipov et al., applied to the synapses of the frog 37. Using this 

method, it was possible to estimate the proximal-distal gradient of calcium transient in the elongated 

frog synapses37. This method of registration can be useful for assessing subcellular calcium dynamics in 

excitable cells, for example, in dendrites and spines in brain slice preparations.” 

 

Minor  

Concerns: 

Methods: 

1. Please avoid the word plastic in the protocols, mention the exact name of the plastic 

(e.g., polystyrene, polypropylene) 

Answer 
 
Thanks, we fixed it 

 

2. The table of materials has typographical errors that need to be corrected. 

 

Answer 
 
Thanks, we try fixed all the mistakes 


